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1 Introduction 

Pipe Flow Wizard is a multi-platform software application that can perform 
calculations to find the pressure loss, flow rate, diameter or length for a single pipe.   
 
Four separate calculation panels allow the user to easily specify the known 
information, calculate the answer and then generate Excel or PDF reports. 
 
The Pipe Flow Wizard software has an intuitive interface that is consistent across 
platforms thereby making it easy for users to perform their calculations and share the 
results regardless of the device being used.  
 
The software is backed up by an unrivalled support service that provides help to 
users when they need it. 
 

1.1 Pipe Flow Wizard Software Overview 

 
Pipeline systems range from single pipelines to very large complex networks with 
hundreds of interconnecting pipes.  They may be simple, carrying water from one 
reservoir to another reservoir, or they may be complex with many interconnecting 
pipes that distribute fluid over a large area, or they could fall somewhere in-between 
such as a system that transfers a fluid from a supply container to a delivery point. 
 
The Pipe Flow Wizard software is designed to calculate pressure loss, flow rate, 
diameter size, or length, for a single pipe. It is a useful tool for piping calculations 
that engineers often need to perform either at the office or out in the field (perhaps to 
work out a required pump head, or to check an expected flow rate or pressure drop). 
 
Note: Our Pipe Flow Expert software can be used to model and calculate flow rates, 
pressure losses and pumping requirements within a complex pipe system. 
 
Each calculation panel has a set of data input fields that enable the known 
information to be entered.  This data typically includes: 
 

• The internal size, roughness and length of the pipe. 

• The elevation change between the start and end of the pipe. 

• The type, quantity and position of fittings on the pipe. 

• The type and characteristics of the fluid in the pipe.  
 
Once the known information has been specified for the required calculation, the 
results can be obtained by clicking Calculate.  The results panel slides up and over 
the inputs panel to concisely display the calculated data which typically includes: 
 

• Friction losses, fitting losses, elevation change gain / losses. 

• Flow type, Reynolds number and Friction factor. 

• Entry and exit pressures. 

• Entry and exit flow rates. 

• Total pressures loss. 

https://www.pipeflow.com/pipe-flow-expert-software
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1.2 Minimum Operating System Requirements 

 

Pipe Flow Wizard has been designed to work on the following operating systems: 

• Microsoft® Windows 10 (All Versions) 

• Microsoft® Windows 8 (all versions except RT [used on ARM based tablets]) 

• Microsoft® Windows 7 (all versions) 

 

We recommended using one of the above operating systems, however the software 
will also run on: 

• Microsoft® Windows Vista (all versions) 

• Microsoft® Windows XP (all versions) 

 

It is recommended that your computer system has at least the following minimum 
specification: 

• Processor: 1.00 GHz or faster CPU 

• Memory (RAM): 2Gb or higher 

• Screen Display: 1024 x 768 pixels (minimum resolution) 

• 1920 x 1080 pixels (or higher recommended) 

• Graphics (RAM): 128 Mb or higher 

• Hard Disk: 50 Mb install (200 Mb free space recommended) 

 

Microsoft® Excel (or compatible software) is required if the user wishes to view an 
Excel Calculation Report. 

A PDF viewer (such as Adobe® Acrobat Reader) is required if the user wishes to 
view a PDF Calculation Report. 

 

Note: 

If your computer will run Windows 7 (or later) then Pipe Flow Wizard should work 
without any issues. 
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1.3 Licensing Information 

 
Pipe Flow Wizard for Windows is a software package that is provided for use on 
personal computer systems. 
 
Installation 
 
When the software is installed it generates a unique product number that is shown 
on the Software License screen when you run the program.  A matching license 
code must be entered to fully enable and license the software. 

 
Purchasing a License 
 
Each installation of the Pipe Flow Wizard software requires a license code to be 
entered in order to fully activate the program. Until the license code is entered the 
software can only be used in trial mode. 

When in Trial Mode, all functionality is available except for the following restrictions: 
 

• Find Pressure - Pipe Diameter cannot be changed. 

• Find Flow Pipe - Diameter cannot be changed. 

• Find Diameter - Pipe Length cannot be changed. 

• Find Length - Pipe Diameter cannot be change. 

• The Gas Data Calculator cannot be used to compute the properties of 
compressible fluids at different temperatures and pressures. 

 

License codes can be purchased from www.pipeflow.com 

Standard licensing and pricing options are shown at www.pipeflow.com 

Figure 1 License Software 

http://www.pipeflow.com/
http://www.pipeflow.com/
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You do not require an internet connection when licensing and enabling the software. 
The software does not need an internet connection to operate. 

 

Moving a License 
 
We allow a user to move the license to another machine. The old license is de-
activated which generates a License Removal Confirmation Number. We then 
provide a new license code for a new installation of the software. This service is 
provided at no further cost as part of the Annual License fee which also includes 
support. 

 

Network Licensing 
 
Contact us at info@pipeflow.com for enquiries about network licensing. 
 
 
Software Distribution Note 
 
Our software for personal computers is provided via download from our web sites at 
www.pipeflow.com and www.pipeflow.co.uk .This helps to reduce our costs, which 
allows us to offer lower prices for our customers and also guarantees that the user is 
always installing the latest version of the software. Users are free to make their own 
copy of the software, however every installation of the program will generate a new 
product code and a new license code will still be required. 
 

Software that is available on mobile devices is completely fulfilled via the relevant 
App Store (e.g. Apple’s App Store), please see www.pipeflow.com for which 
products are available on mobile devices. 
 
 
New Customers 
 
Those of you who have previously purchased software from us will already be 
assured of our reputation and will not be concerned about receiving the software via 
download. However, we understand that as a new customer you may be concerned 
that you do not receive physical media with the software on. 

If we provided the software on physical media, it would be the exact same program 
that you can download from our web site (in fact the web site will always carry the 
very latest version of the software). Having a physical media would not allow you to 
install and enable the software on multiple computers, since each installation would 
still generate a unique product number and would require a matching license code. 

When you purchase a program from our web site, you will automatically be emailed 
with a unique purchase token and an invoice/receipt that confirms your purchase. 
This is all you need for proof of purchase and we will always be able to confirm your 
purchase in our database. 

We have sold software via download for over 20 years. We are not one of those 
companies who you will not be able to contact or get a response from. As our 

mailto:info@pipeflow.com
http://www.pipeflow.com/
http://www.pipeflow.co.uk/
http://www.pipeflow.com/
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existing customers know, our service and assistance with any issues you may have 
is worth far more than just having the software on physical media. 

In some cases, we may sell a license to use a copy of the software on a USB drive. 
When this option is purchased, we send you a ‘Pipe Flow’ branded USB drive and 
allow you to license this. This provides a completely portable copy of the software. 
There is nothing to install. The USB drive can be plugged in to any compatible 
personal computer and the software can then be run directly from the USB drive, up 
into the memory of the local computer.  Please see www.pipeflow.com for which 
products are available on a USB drive. 

 

Summary 
 

• The Pipe Flow Wizard software can be downloaded and installed for a free 
trial. 

• A license code can be purchased from our web site at www.pipeflow.com that 
will enable use of the software for a specific time period (normally 12 months). 

• A user can be up and running with a licensed version of the software within a 
few minutes. 

• An Annual License fee must be paid to extend the license to use the software 
for a further 12 months, once any previous license period ends. The Annual 
License fee can be paid at www.pipeflow.com. 

• Software support and maintenance, including technical assistance, help with 
modeling issues and free upgrades to new releases, are provided for free 
while you are running a licensed copy of the Pipe Flow Wizard software. This 
ensures that you will always be able to use the latest version of the software. 

  

http://www.pipeflow.com/
http://www.pipeflow.com/
http://www.pipeflow.com/
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1.4 Contacting Pipe Flow Software 

 
Email:                 wizard@pipeflow.com 

Internet:              http://www.pipeflow.com 

 

UK Telephone:   +44 (0)161 408 3569 

 

USA Telephone: +1 650-276-3569 

                             +1 650-276-FLOW 

 

Pipe Flow Software, PipeFlow.com and PipeFlow.co.uk are trading names of 
Daxesoft Ltd, a U.K. Registered Company) 

  

mailto:wizard@pipeflow.com
http://www.pipeflow.com/
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1.5 Additional Pipe Flow Software Programs 

 
 
Pipe Flow Expert – software for designing piping and pumping systems 
 
Pipe Flow Expert can be used to model pipe systems with just a few pipes through to 
more complex systems with many hundreds of pipes. 
 
For more information about Pipe Flow Expert, see: 
 
 www.pipeflow.com/pipe-flow-expert-software 
 
 
Pipe Flow Advisor – software for calculating flow in Channels and Tanks 
 
Pipe Flow Advisor may be used to estimate water flow rate from various shaped 
channels and tanks. It can calculate: 
 

• Open Channel Flow 

• Water Flow Rates 

• Time taken to empty tanks 

• Volume, Capacity, Weight and Expansion 
 
For more information about Pipe Flow Advisor, see: 
 
www.pipeflow.com/pipe-flow-advisor-software. 
 
Pipe Flow Software programs can all be downloaded for a free trial by visiting 
 
www.pipeflow.com. 
 
Once you have installed a trial version of one of our software products it can be fully 
enabled and licensed by buying a license code from our web site. You can be up and 
running with a fully licensed program within just a couple of minutes. 
  

https://www.pipeflow.com/pipe-flow-expert-software
http://www.pipeflow.com/pipe-flow-advisor-software
http://www.pipeflow.com/
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2 Interface and Menus 

This section details the different features of the Pipe Flow Wizard interface.  For 
each feature, there is an explanation, a screen shot and a table providing 
descriptions for each element of the feature.  The following sections provide 
instructions for using the Pipe Flow Wizard application. 

 

 

2.1 Main Menu Bar 

 
The main menu bar has seven different sections to help you navigate and work in 
Pipe Flow Wizard. 
 

  

Figure 2 Interface and Menus 

Figure 3 Main Menu Bar 
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2.1.1 File Menu 

 

 

Menu Items Description 

 
Load 
 

Loads a previously saved calculation.  The calculation 
type is defined by the extension of the filename. For 
more information about Pipe Flow Wizard file 
extensions: see Filename Extensions. 
Keyboard shortcut: Ctrl + L 

Save 

Opens the Save sub-menu.  Selecting the required 
calculation opens the Save dialog.  Browse to where 
you want to save the calculation, name the file (the 
extension will be added automatically) and click 
Save.  

Excel Report 
Opens the Excel Report sub-menu.  If the calculation 
is in results mode, selecting the required calculation 
will generate an Excel report for the calculation.   

PDF Report 
Opens the PDF Report sub-menu.  If the calculation 
is in results mode, selecting the required calculation 
will generate a PDF report for the calculation.   

Create Screenshot 
Opens the Create Screenshot sub-menu.  Selecting 
the required calculation will create a screenshot of 
that calculation panel. 

Exit Pipe Flow Wizard 

Closes the application.  You can configure whether a 
confirmation dialog is displayed prior to the 
application being closed on the General tab of the 
Settings screen.  
Keyboard shortcut: Ctrl + Q 

  

Figure 4 File Menu 
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2.1.2 Units Menu 

 

 
 

Menu Items Description 

 
Metric Units 
 

Sets all units for all calculations to be metric units. 
Keyboard shortcut: Ctrl + M 

Imperial Units 
Sets all units for all calculations to be imperial units.  
Keyboard shortcut: Ctrl + I 

Specify Units… 
Open the Units tab of the Settings screen so that 
specific units for each calculation can be specified.   

  

Figure 5 Units Menu 
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2.1.3 License Menu 

 

 
 

Menu Items Description 

License Status 
Displays the current license status and entry fields for 
entering license codes. 

View License Agreement View agreement between Licensor and Licensee.  

Remove / Move License 

Displays instructions that explain how to deactivate 
the current license to obtain a license removal 
confirmation code, which confirms the license is no 
longer in use. A license for a new installation can then 
be requested (any new installation will require a new 
license code).   

  

Figure 6 License Menu 
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2.1.4 View Menu 

 

 
 

Menu Items Description 

 
Tabs 
 

Switches from the Column display format to Tab 
display format.   
Keyboard shortcut: Alt + T. 

Columns 
Switches from the Tab display format to the Column 
display format.   
Keyboard shortcut: Alt + C. 

Go to Calculation 
Opens the Go to Calculation sub menu to ‘go to’ a 
specific calculation.  See Go to Calculation keyboard 
shortcuts in the table below. 

 
 

Keyboard Shortcut Description 

 
F1 
 

Go to the Find Pressure calculation. 

F2 Go to the Find Flow calculation. 

F3 Go to the Find Diameter calculation. 

F4 Go to the Find Length calculation. 

  

Figure 7 View Menu 
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2.1.5 Tools Menu 

 

 
 

Menu Items Description 

Settings 
Open the Settings screen. 
Keyboard shortcut: Ctrl + S 

 
  

Figure 8 Tools Menu 



Pipe Flow Wizard for Windows  User Guide 
 

 21 

2.1.6 Verification Menu 

 

 
 

Menu Items Description 

Open Non-Compressible 
Results Verification PDF 

Open the Non-Compressible (Liquids) Calculation 
Results Verification PDF document. 

Open Compressible Gas 
Results Verification PDF 

Open the Compressible (Gases) Calculation Results 
Verification PDF document. 

Open Compressible Gas 
Flow Equations PDF 

Open the Compressible Flow Equations & formula 
descriptions PDF. 

  

Figure 9 Verification Menu 
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2.1.7 Help 

 

 
 

Menu Items Description 

 
Open User Guide PDF 
 

Open the User Guide PDF document (this 
document). 

Open Pipe Flow Wizard 
Brochure PDF 

Open the Pipe Flow Wizard PDF Brochure. 

Go to www.pipeflow.com Open www.pipeflow.com in a web browser. 

About Pipe Flow Wizard 
Open the Pipe Flow Wizard About screen.   
Keyboard shortcut: Ctrl + A. 

  

Figure 10 Help Menu 

http://www.pipeflow.com/
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2.2 Calculation Panel 

 
Each calculation has its own colored calculation panel. 
 

 
 

 
The calculation panel allows you to enter known information for the required 
calculation: 
 
The Material name, Schedule and Internal Roughness of the pipe can be 

specified by clicking the Pipe  to open the Pipe Material screen from where a 
material can be selected from the database or a new material defined.  For more 
information about working with pipe materials, see: Pipe Material & Diameters. 
 
The Internal Diameter (for Find Pressure, Find Flow and Find Length) of the pipe 

can be specified by clicking the Diam.  button to open the Pipe Diameter 
screen from where a pipe size can be selected from the database or a new size 
defined.  For more information about working with pipe diameters, see: Pipe Material 
& Diameters. 
 

Fittings can be added to the pipe by clicking the Fittings  button to open the 
Fitting Screen from where fittings can be selected, or new fittings defined.  For more 
information about working with fittings, see: Fittings & Valves 
 
The pipe’s Elevation change can be specified by entering the difference in height 
from the start of the pipe to the end of the pipe in the Elevation Change field and 
specifying whether this is a rise or fall. 
 

The Fluid in the pipe can be specified by clicking a fluid button (Liquids  or 

Gases  ) to open the Fluids Database screen from where fluids can be 
selected, or new fluids defined.  For more information about working with fluids, see 
Fluids Database. 
 

Find Pressure Find Flow Find Diameter Find Length 

Figure 11 Calculation Panel 
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The Flow rate (For Find Pressure, Find Diameter and Find Length) of the fluid can 

be specified by entering the value into the Flow field or clicking the expander  
button (where applicable) to open the Flow Rate Calculator.  For more information 
about entering a flow rate based on a velocity using the Flow Rate Calculator, see: 
Flow Rate Calculator / Helper. 
The Pressure Loss (for Find Flow, Find Diameter and Find Length) in the pipe can 
be specified by entering the value into the Pressure Loss field. 
 
Click the Calculate button to solve the calculation using the data supplied.   
 
The Results Panel will slide up and over the calculation panel to display the results 
of the calculation.  For more information about the results panel, see: Results Panel. 
 

Depending upon the amount of information in the calculation panel and/or the 
height of the program window, it may be necessary to scroll down to reveal 
further information. 

 
 

2.2.1 Calculation Menu Bar 

 
 
In the header of each calculation panel is the calculation menu bar. 
 

 
The menu bar contains four buttons which provides quick access to: 
 

Menu Items Description 

 

        
 

Loading a new calculation from disk. 

         Saving the currently active calculation. 

Figure 12 Calculation Menu Bar 
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         Taking a screenshot of the currently active calculation. 

         Specifying the units for the currently active calculation. 
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2.3 Results Panel 

 
When a calculation is solved, the Results Panel slides up and over the Calculation 
Panel. 
 
The results panel displays the data that was entered by the user at the top in the 
Inputs section and displays the results beneath the inputs in the Results section. 

 
The display unit for each different item of data can be changed in Settings.  In 
addition, for the main result (e.g. Pressure Drop for Find Pressure), the display unit 
can be changed by selecting the unit from the drop-down list.  When the result panel 
is closed, and another calculation is performed, the result unit will be reset to the unit 
that is specified in settings for that attribute.  For more information about setting 
units, see: Units. 
 

Clicking the expander  button for a result attribute will reveal further data 
associated with that attribute.  For further information about expanders, see: 
Expandable Sections. 

Figure 13 Results Panel 
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2.3.1 Results Menu Bar 

 
In the header of each result panel is the results menu bar. 
 

 
 
The menu bar contains four buttons which provides quick access to: 
 

Menu Items Description 

 

         
 

Creating and viewing an Excel Report.  For more 
information about Excel Reports, see: Creating a 
Report of the Results. 

         

Creating and viewing a PDF Report.  For more 
information about PDF Reports, see: Creating a 
Report of the Results. 

         

Copying the calculation data to one or more 
calculations.  For more information about copying 
calculations, see: Copying Calculation Results for use 
in another Calculation. 

         Closes the results panel. 

 
 

Depending upon the amount of information in the result panel and/or the height 
of the program window, it may be necessary to scroll down to reveal further 
information. 

  

Figure 14 Results Menu Bar 
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2.4 Expandable Sections 

 
Pipe Flow Wizard uses expandable sections to allow the user to increase or reduce 
the information that is displayed.  Sections that can be expanded display the 
expander button  which when clicked will expand the section to reveal more 
information.  Clicking the expander button when the section is expanded will collapse 
the section. 
 
 

  

Figure 15 Expandable Sections 
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3 Views 

Pipe Flow Wizard can be configured in either Column view or Tab view. 

To view multiple calculations simultaneously, the column view can be used.  If you 
need to see just a single calculation or prefer a more compact view, the Tab view 
can be used. 

3.1 Column View 

 
The column view displays all calculations together, side by side (assuming there is 
sufficient screen resolution / width). 
 
The column view can be displayed by selecting View > Columns on the main menu 
bar or by using the keyboard shortcut Alt + C. 
 

 
 
Figure 16 Column View 
 

 
Clicking on a calculation panel or result panel will make that calculation active.  The 
other calculations become inactive and are visually greyed out. 
 
As the size of the Pipe Flow Wizard window is reduced in width, the calculation 
panels automatically collapse if there is insufficient room to display them.  The 
collapsed panels are shown as ‘book spine’.  Clicking a collapsed calculation (‘book 
spine’) will expand that calculation and automatically collapsed another one, thereby 
always maintaining the same number of calculations visible. 
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Figure 17 Column View - Collapsed 
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3.2 Tab View 

 
The tab view displays a single calculation.   
 
Each calculation can be accessed by the following methods: 
 

• Click on the required calculation Tab 

• Select View > Go to Calculation > [Required Calculation] 

• Clicking the keyboard shortcut key for the required calculation.  For 
information about the View menu item keyboard shortcuts, see: View Menu. 

 
The tab view can be displayed by selecting View > Tabs on the main menu bar or by 
using the keyboard shortcut Alt + T. 

  

Figure 18 Tab View 
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4 Settings 

Pipe Flow Wizard can be configured and set-up to the user’s working preferences. 
The settings screen is opened by clicking Tools > Settings or using the shortcut 
Ctrl+S. 
 

 

Tab Name Description 

Units Configure the defaults units for each calculation.  

Results Decimals 
Configure the number of post decimal places used to 
display results values. 

General 
Configure system wide (non-calculation specific) 
program options. 

Reports Configure the Excel and PDF Reports. 

Reset Reset program settings and data. 

Figure 19 Settings 
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4.1 Units 

 
The Units screen is opened by clicking Units > Specify Units on the Main Menu Bar 

or clicking the Units  button in the Calculation Menu Bar of any of the calculations. 
 

 
Units for each of the calculations can be specified by: 
 

1. Selecting the required calculation from the ‘Select Calculation’ drop down.  
2. Selecting the required unit for each of the attributes, OR 

Selecting Imperial / Metric to change all units for that calculation. 
3. Click OK. 

 

Scroll down to reveal more units. 

  

Figure 20 Units 
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4.2 Results Decimals 

 
The Result Decimals screen is opened by clicking Tools > Settings on the Main 
Menu Bar and selecting the Results Decimals tab. 
 

 
 
The number of post decimal digits for each attribute can be specified individually, or 
all attributes can be set to the same number of post decimals by selecting a value 
from the Set All Decimals drop down and clicking Set All Decimals. 
 
The number of post decimal digits can be reset to their default values by tapping 
Reset to Defaults. 
 
All results data displayed on the Results Panel and in the Excel / PDF reports will be 
displayed to the number of post decimals specified. 

 
Scroll down to reveal more attributes. 

  

Figure 21 Results Decimals 
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4.3 General 

 
 
 

Option Description 

Show clear value 
buttons 
 

When checked, edit boxes contain a clear value  
button that when clicked will erase the contents of the 
edit box. 

Ask before quitting 
When checked, Pipe Flow Wizard will display a 
confirmation dialog box before closing.  

Enable mouse wheel to 
change drop down 
values 

When checked, drop down values (e.g. units) can be 
changed by hovering over the drop down and moving 
the mouse wheel.   

 
  

Figure 22 Settings General 
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4.4 Reports 

 

 
 

Option Description 

 
Excel File Format 
 

Configure the version of Excel that will be used. 

Font Size Configure the font size to use for the report.  

Paper Size Configure the paper size to use for the report.   

Tabulated Units 

When checked, units will be displayed in their own 
column.  When un-checked, units will be displayed 
next to their value in the same column.  For examples 
of tabulated and non-tabulated reports, see:  PDF 
Report Example – Tabulated Units and  PDF Report 
Example – Non-Tabulated Units 

  

Figure 23 Settings - Reports 
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4.5 Reset 

 

 

Option Description 

 
Reset All Settings 
 

Reset all settings values to defaults. 
Only applied to the calculations if OK is clicked. 

Reset All Calculations 
Reset all calculation values to defaults. 
Applied immediately after confirmation has been 
given. 

Restore Standard 
Material 

Restore standard materials that have been deleted. 
Applied immediately after confirmation has been 
given.   

  

Figure 24 Settings - Reset 
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5 File and Calculation Operations 

5.1 Filename Extensions 

 
The filename extensions for each calculation are as follows: 
 

Calculation File Extension 

Find Pressure pfwp 

Find Flow pfwf  

Find Diameter pfwd   

Find Length pfwl   

 

5.2 Data File Location 

 
The location of the data files (e.g. fluid data, pipe data, user configuration, licence 
etc.) is, by default, as follows: 
 
Users\Public\Public Documents\Pipe Flow Wizard\ 

 
The location of the data files can be modified by editing the pfwizarddata.ini file 

which is in the same directory as the Pipe Flow Wizard program, e.g.: 
 
Program Files (x86)\Pipe Flow Wizard 

 
To specify a new location for the data files, open the pfwizarddata.ini file in a text edit 
(e.g. Notepad) and insert the following: 
 
Datapath:<full absolute path for location of data files> 
 
e.g. datapath:d:\mydata\pipeflowwizard  

 
Save and close the pfwizarddata.ini file and then re-start Pipe Flow Wizard. 

 
The constants defined in the following table can be used within the 
pfwwizarddata.ini file.  Constants will be translated to their literal values by 

Pipe Flow Wizard. 
 
e.g. datapath:{INSTALLDIR}\mydata\pipeflowwizard  
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Constant Literal Value 

 
{INSTALLDIR} 
 

The directory in which Pipe Flow Wizard has been 
installed (e.g. c:\Program Files (x86)\Pipe Flow 
Wizard)  
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6 Pressure Drop Calculation 

The Pressure Drop through the pipe can be calculated when the following values 
are known: 

• Pipe internal roughness 

• Pipe internal diameter 

• Pipe length 

• Pipe elevation change 

• Fittings 

• Flow rate 

 

The Pressure Drop can be calculated for both Liquids and Gases.  For information 
about selecting a fluid, see: Fluids Database. 

 

For more information about working with gases, see: Working with Compressible 
Fluids. 

 

For more information about the theory and formulas used to calculate the pressure 
loss, see Calculation Theory and Method of Solution. 
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6.1 Pressure Drop Calculation - Liquid 

 

The pressure drop for a liquid in a pipe can be calculated as follows: 
 

1. Select the Find Pressure calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Length and Elevation Change of the pipe. 

5. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

6. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

7. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate based on a velocity, see: Flow Rate Calculator / Helper. 

8. Click Calculate Pressure Drop and the Results Panel will slide up. 

Figure 25 Find Pressure Calculation - Liquid 
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The internal diameter will be reset to 1.049” (26.64 mm) if running the trial 
version of Pipe Flow Wizard. 

 

The Find Pressure Results Panel displays the calculation input data and the results 
of the Pressure Drop calculation.  For more information about the Results Panel, 
see: Results Panel. 

The pressure loss unit can be changed as required.  To change the pressure loss 
unit for all subsequent calculations, the pressure loss unit can be specified in 
Settings > Units.  For more information about setting units, see: Units 

To generate and view an Excel or PDF Report of the results, click the Excel button 

or PDF  button.  For more information about generating reports, see:  Creating a 
Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

 

 

Figure 26 Find Pressure Results - Liquid 



Pipe Flow Wizard for Windows  User Guide 
 

 43 

6.2 Pressure Drop Calculation - Gas 

 

The pressure drop for a gas in a pipe can be calculated as follows: 

 

1. Select the Find Pressure calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Length and Elevation Change of the pipe. 

5. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

6. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

7. Enter the Pressure of the fluid at the start of the pipe. 

8. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate based on a velocity, see: Flow Rate Calculator / Helper. 

Figure 27 Find Pressure Calculation - Gas 
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9. Click Calculate Pressure Drop and the Results Panel will slide up. 
 

The internal diameter will be reset to 1.049” (26.64 mm) if running the trial 
version of Pipe Flow Wizard. 

 

The Find Pressure Results Panel displays the calculation input data and the results 
of the Pressure Drop calculation.  For more information about the Results Panel, 
see: Results Panel. 

The pressure loss unit can be changed as required.  To change the pressure loss 
unit for all subsequent calculations, the pressure loss unit can be specified in 
Settings > Units.  For more information about setting units, see: Units 

To generate and view an Excel or PDF Report of the results, click the Excel button 

or PDF  button.  For more information about generating reports, see:  Creating a 
Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

Figure 28 Find Pressure Results - Gas 
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7 Flow Rate Calculation 

The Flow Rate through the pipe can be calculated when the following values are 
known: 

• Pipe internal roughness 

• Pipe internal diameter 

• Pipe length 

• Pipe elevation change 

• Fittings 

• Pressure Loss 

 

The Flow Rate can be calculated for both Liquids and Gases.  For information about 
selecting a fluid, see: Fluids Database. 

 

For more information about working with gases, see: Working with Compressible 
Fluids. 

 

For more information about the theory and formulas used to calculate the flow rate, 
see Calculation Theory and Method of Solution. 

  



Pipe Flow Wizard for Windows  User Guide 
 

 46 

7.1 Flow Rate Calculation - Liquid 

 

The flow rate for a liquid in a pipe can be calculated as follows: 

 

1. Select the Find Flow calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Length and Elevation Change of the pipe. 

5. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

6. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

7. Enter the Pressure Loss. 

8. Click Calculate Flow, the Results Panel will slide up. 

Figure 29 Find Flow Calculation - Liquid 
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The internal diameter will be reset to 1.049” (26.64 mm) if running the trial 
version of Pipe Flow Wizard. 

 

The Find Flow Results Panel displays the calculation input data and the results of 
the Find Flow calculation.  For more information about the Results Panel, see: 
Results Panel. 

The Flow units can be changed as required.  To change the flow units for all 
subsequent calculations, the flow unit can be specified in Settings > Units.  For more 
information about setting units, see Units. 

To generate and view an Excel or PDF Report of the results, click the Excel button 

or PDF  button.  For more information about generating reports, see:  Creating a 
Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

  

Figure 30 Find Flow Results - Liquid 
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7.2 Flow Rate Calculation - Gas 

 

The flow rate for a gas in a pipe can be calculated as follows: 

 

1. Select the Find Flow calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Length and Elevation Change of the pipe. 

5. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

6. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

7. Enter the Pressure of the fluid at the start of the pipe. 

8. Enter the Pressure Loss. 

Figure 31 Find Flow Calculation - Gas 
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9. Click Calculate Flow, the Results Panel will slide up. 

The internal diameter will be reset to 1.049” (26.64 mm) if running the trial 
version of Pipe Flow Wizard. 

 

The Find Flow Results Panel displays the calculation input data and the results of 
the Find Flow calculation.  For more information about the Results Panel, see: 
Results Panel. 

The Flow units can be changed as required.  To change the flow units for all 
subsequent calculations, the flow unit can be specified in Settings > Units.  For more 
information about setting units, see Units. 

To generate and view an Excel or PDF Report of the results, click the Excel button 

or PDF  button.  For more information about generating reports, see:  Creating a 
Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.  

Figure 32 Find Flow Results - Gas 
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8 Pipe Diameter Calculation 

The Minimum Internal Diameter of the pipe can be calculated when the following 
values are known: 

• Pipe internal roughness 

• Pipe length 

• Pipe elevation change 

• Fittings 

• Required flow rate 

• Maximum allowed pressure drop 

 

The Pipe Diameter can be calculated for both Liquids and Gases.  For information 
about selecting a fluid, see: Fluids Database. 

 

For more information about working with gases, see: Working with Compressible 
Fluids. 

 

For more information about the theory and formulas used to calculate the pipe 
diameter, see Calculation Theory and Method of Solution. 
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8.1 Pipe Diameter Calculation - Liquid 

 

The minimum internal diameter of a pipe that contains a liquid can be calculated as 
follows: 

 

1. Select the Find Diameter calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Set the Length and Elevation Change of the pipe. 

4. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

5. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

6. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate, see: Flow Rate Calculator / Helper. 

7. Enter the maximum Pressure Loss of in the pipe. 

8. Click Calculate Diameter and the Results Panel will slide up. 

Figure 33 Find Diameter Calculation - Liquid 



Pipe Flow Wizard for Windows  User Guide 
 

 52 

The length will be reset to 32.80 ft (10 m) if running the trial version 
of Pipe Flow Wizard. 

 

The Find Diameter Results Panel displays the calculation input data and the results 
of the Find Diameter calculation.  For more information about the Results Panel, 
see: Results Panel. 

The Diameter units can be changed as required.  To change the diameter units for 
all subsequent calculations, the diameter unit can be specified in Settings > Units.  
For more information about setting units, see: Units. 

To generate and view an Excel or PDF Report of the results, click the Excel button 

or PDF  button.  For more information about generating reports, see:  Creating a 
Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

 

Figure 34 Find Diameter Results - Liquid 
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8.2 Pipe Diameter Calculation - Gas 

 

The minimum internal diameter of a pipe that contains a gas can be calculated as 
follows: 

 

1. Select the Find Diameter calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Set the Length and Elevation Change of the pipe. 

4. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

5. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

6. Enter the Pressure of the fluid at the start of the pipe. 

7. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate, see: Flow Rate Calculator / Helper. 

8. Enter the maximum Pressure Loss in the pipe. 

Figure 35 Find Diameter Calculation - Gas 
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9. Click Calculate Diameter and the Results Panel will slide up. 

The length will be reset to 32.80 ft (10 m) if running the trial version 
of Pipe Flow Wizard. 

 

The Find Diameter Results Panel displays the calculation input data  and the 
results of the Find Diameter calculation.  For more information about the Results 
Panel, see: Results Panel. 

The Diameter units can be changed as required.  To change the diameter units for 
all subsequent calculations, the diameter unit can be specified in Settings > Units.  
For more information about setting units, see: Units. 

To generate and view an Excel or PDF Report of the results, click the Excel  

button or PDF  button.  For more information about generating reports, see:  
Creating a Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

 

Figure 36 Find Diameter Results - Gas 
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9 Pipe Length Calculation 

The pipe Length can be calculated when the following values are known: 

• Pipe internal roughness 

• Pipe internal diameter 

• Pipe elevation change 

• Required flow rate 

• Maximum allowed pressure drop 

 

The Pipe Length can be calculated for both Liquids and Gases.  For information 
about selecting a fluid, see: Fluids Database. 

 

For more information about working with gases, see: Working with Compressible 
Fluids. 

 

For more information about the theory and formulas used to calculate the pipe 
length, see Calculation Theory and Method of Solution. 
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9.1 Pipe Length Calculation - Liquid 

 

The maximum length of a pipe that contains a liquid can be calculated as follows: 

 

1. Select the Find Length calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Elevation Change of the pipe. 

5. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database. 

6. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate, see: Flow Rate Calculator / Helper. 

7. Enter the Pressure Loss in the pipe.  

8. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

Figure 37 Find Length Calculation - Liquid 
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9. Click Calculate Length and the Results Panel will slide up. 
 

The internal diameter will be reset to 1.049” (26.64 mm) if running the trial 
version of Pipe Flow Wizard. 

 

The Find Length Results Panel displays the calculation input data and the results 
of the Find Length calculation.  For more information about the Results Panel, see: 
Results Panel. 

The Length units can be changed as required.  To change the length units for all 
subsequent calculations, the length unit can be specified in Settings > Units.  For 
more information about setting units, see: Units. 

To generate and view an Excel or PDF Report of the results, click the Excel  

button or PDF  button.  For more information about generating reports, see:  
Creating a Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

  

Figure 38 Find Length Results - Liquid 
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9.2 Pipe Length Calculation - Gas 

 

The maximum length of a pipe that contains a gas can be calculated as follows: 

 

1. Select the Find Length calculation. 

 

2. Select or define the Material and Internal Roughness of the pipe.  For more 
information about working with pipe materials, see: Pipe Material & 
Diameters. 

3. Select or define the Internal Diameter of the pipe.  For more information 
about working with pipe diameters, see: Pipe Material & Diameters. 

4. Set the Elevation Change of the pipe. 

5. Select the Fluid in the pipe.  For more information about working with fluids, 
see: Fluids Database.  

6. Enter the Flow Rate of the fluid in the pipe.  For more information about 
setting a flow rate, see: Flow Rate Calculator / Helper. 

7. Enter the Pressure of the fluid at the start of the pipe. 

8. Enter the Pressure Loss in the pipe.  

Figure 39 Pipe Length Calculation - Gas 
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9. Add Fittings to the pipe if required.  For more information about working with 
fittings, see: Fittings & Valves.   

10. Click Calculate Length and the Results Panel will slide up. 
 

The internal diameter will be reset to 1.049” (26.64 mm) if running 
the trial version of Pipe Flow Wizard. 

 
The Find Length Results Panel displays the calculation input data  and the results 
of the Find Length calculation.  For more information about the Results Panel, see: 
Results Panel. 

The Length units can be changed as required.  To change the length units for all 
subsequent calculations, the length unit can be specified in Settings > Units.  For 
more information about setting units, see: Units. 

To generate and view an Excel or PDF Report of the results, click the Excel  

button or PDF  button.  For more information about generating reports, see:  
Creating a Report of the Results. 

To copy the calculation data to one or more other calculations, click the Copy  
button and select the required calculation(s). 

To close the Results Panel, click the Close  button in the corner or the Close 

Results  button at the bottom.   

Figure 40 Pipe Length Results - Gas 
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10 Fluids Database 

Pipe Flow Wizard includes a fluid database.  The Fluid Properties list displays all the 
fluids available in the fluid database for either liquids or gases.  When you are 
selecting a fluid to be used for a calculation, you can select an existing fluid, or enter 
your own fluid data.  Once entered, new fluid data will show up in the list of fluids and 
can then be used just the same as the standard fluid data. 
 
The Fluid Data can be defined and overwritten in the fluid properties section of the 
Fluid data screen. 
 
New fluid data can be added to the existing database entries by clicking the Add 
Fluid button. 
 

 

  

Figure 41 Fluids Database 
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To define the fluid and fluid properties for the currently selected calculation: 

1. Click the fluid button (Liquids  or Gases  ) on the calculation panel. 

2. Select the fluid contained in the pipe from the Fluid Database list. 

3. If the fluid is not in the Fluid Database list, click the Add Fluid button to add 
the new fluid data to the list.  For more information about adding fluid data, 
see: Adding Fluid to the Fluid Database and Adding Gas Data to the Fluid 
Database. 

4. Click the Use Fluid button or double-click the row containing the fluid. 

5. The selected fluid is displayed in the Fluid Properties section. 

6. Edit the applicable fluid properties in the Fluid Properties section. 

7. The edits you make only affect the fluid properties for the calculation; they do 
not affect the database data. 

8. Click Save to save the fluid data to be used with the currently selected 
calculation. 

 

The name of the fluid is displayed in the calculation next to the fluid buttons. 
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10.1  Adding Fluid to the Fluid Database 

 
If the fluid you are using does not exist in the Pipe Flow Wizard fluid database, you 
can quickly add the fluid to the database by clicking the Add Fluid button on the 
Fluids screen. 
 
NOTE: Be sure to enter the value for the fluid’s properties in the units displayed in 
the column header. For example, if you are using imperial units, oF for Fahrenheit is 
displayed under Temperature in the Temperature column.  The temperature value in 
this case should be entered in degrees Fahrenheit. 
 
To add a new fluid to the fluid database: 
 

1. Click the Fluid button (Liquids  or Gases  ) on the calculation panel. 

2. Click the Add Fluid button. 

3. On the confirmation dialog that is displayed, click Yes if you want all current 
fluid properties in the Fluid Properties section to be cleared, otherwise click 
No to retain the current fluid property values so that you can modify them as 
required. 

4. Enter the fluid’s name in the Name field. 

5. Enter the fluid’s formula in the Formula field. 

6. Enter the fluid’s temperature in the Temperature field. 
 

7. Enter the fluid’s density in the Density field. 
 

8. Enter the fluid’s viscosity in the Viscosity field. 
 

9. For a liquid, enter the fluid’s vapor pressure in the Vap. Press. field. 
 

10. For a gas, enter the fluid’s specific heat ratio in the Specific Heat Ratio field. 
 

11. Select whether the fluid is a liquid or a gas in the State drop down field. 
 

12. Click Save to save the new fluid data to the Fluid Database. 
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10.2  Adding Gas Data to the Fluid Database 

 
If the fluid you are using is one of the included gases, the viscosity and density of the 
gas at various temperatures and pressures can be calculated. 
 
To add a new gas to the fluid database: 
 

1. Click the Gas button   on the calculation panel. 

2. Click the Calculate Gas Data button to display the Gas Data Calculator. 

 

3. Choose a Gas from the drop-down listing. 

4. Enter the temperature of the gas. 

5. Enter the pressure of the gas. 

6. Click Calculate Gas Data. 

7. The density, viscosity and specific heat ratio for the gas are displayed. 

8. Click Save To Fluid Database to add the data to the fluid database. 

  

Figure 42 Gas Data Calculator 

The Gas Data Calculator will 
not generate fluid data if 
running the trial version of Pipe 
Flow Wizard. 
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11 Pipe Material & Diameters 

Pipe Flow Wizard includes a database of common pipe materials for which a range 
of pipe characteristics (internal roughness, nominal size and internal diameter) are 
defined. 
 
If the pipe you are using does not exist in the database, then its characteristics can 
be entered manually and optionally added to the database. 
 

11.1  Selecting a Pipe Material 

 
To select a pipe material: 
 

1. Click the on the Pipe  button on the calculation panel to open the Pipe 
Material screen. 

 
2. Select the Material name from the drop-down list. 

 
3. Click the Use Material button. 

  

Figure 43 Pipe Material 
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11.2  Editing a Pipe Material 

 
To edit a pipe material: 
 

1. Click the on the Pipe  button on the calculation panel to open the Pipe 
Material screen. 

2. Click the Edit button. 

 
3. Overtype the Name, Schedule / Class, and Internal Roughness values. 

 
4. Click the Use Material button. 

 
 

11.3  Adding a new Pipe Material 

 
To add a pipe material: 
 

1. Click the on the Pipe  button on the calculation panel to open the Pipe 
Material screen. 

2. Click the New button. 

 

3. Enter the Name, Schedule / Cass, and Internal Roughness values. 

 
4. Click the Save Material button to save the new material to the database or 

click Use Material to apply the material to the calculation without saving. 

  

Figure 44 Edit Pipe Material 

Figure 45 Add Pipe Material 
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11.4 Selecting a Pipe Diameter 

 
To select a pipe diameter: 
 

1. Click the Diam.  button on the calculation panel to open the Pipe 
Diameter screen.  

 
2. If required, change and select the pipe material from the Material Database 

list. 
 

3. Double click on a row in the list of pipe diameters, or select a row from the list 
of pipe diameters and click the Transfer Pipe button, to update the Pipe 
Material and size information. 
 

4. Click the Use Pipe button.  

Figure 46 Pipe Diameter 
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11.5  Editing a Pipe Diameter 

 
To edit a pipe diameter: 
 

1. Click the Diam.  button on the calculation panel to open the Pipe 
Diameter screen.  
 

2. In the Pipe Material / Pipe Size section, overtype the values as required. 
 

3. Click the Use Pipe button. 
 

 

11.6  Adding a Pipe Diameter 

 
To add a new pipe diameter: 
 

1. Click the Diam.  button on the calculation panel to open the Pipe 
Diameter screen. 
 

2. Click the Add Size button. 
 

 
3. Specify the Nominal Size and Internal Diameter values. 

 
4. Click Save Size. 

 
 

  

Figure 47 Add Pipe Diameter 
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12 Fittings & Valves 

Up to five different fitting types can be added to a pipe.  Multiple fittings of each type 
can be specified, and each fitting type can be selected to be at the start or end of the 
pipe.   

Fittings can be selected from the Pipe Flow Wizard Fitting database, or user fittings 
can be created using an appropriate K value. 

 

12.1  Adding a Fitting to the Pipe 

 
To add fittings to a pipe: 
 

1. Click the Fittings  button on the calculation panel to open the Fittings 
screen. 

 
2. The fittings on the pipe will be shown in the Fittings on section at the top of 

the screen.  
 

3. A list of available fittings will be shown for the current pipe size. 
 

Figure 48 Fittings & Valves 
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4. If required, change the nominal metric or imperial size from the drop-down list 
to display the available fittings and their associated K value for a different 
size. 
 

5. If the fitting is not in the Fitting Database list, click the Create Fitting button 
to add the new fitting to the list.  For more information about adding a fitting to 
the database, see: Adding a Fitting to the Pipe. 
 

6. Double click on a fitting from the list to add it to the fittings on the pipe. 
 

7. The selected fitting is displayed in the Fittings on section of the Fittings 
screen. 
 

8. Select the position of the fitting on the pipe to be either Entry or Exit, and 
select the quantity of each fitting from the Qty drop down list. 
 

9. To add additional fittings to the pipe, repeat Steps 4 – 8. 
 

10. Click Save to add the chosen fittings to the pipe, and to close the Fittings 
screen. 

 

 

12.2  Removing a Fitting from the Pipe 

 
To remove fittings from a pipe: 
 

1. Click the Fittings  button on the calculation panel to open the Fittings 
screen. 
 

2. Select the fitting to be removed in the Fittings on section of the Fittings 
screen. 

 
3. Click the Delete  button for the selected fitting. 

 

Figure 49 Fittings on the Pipe 
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4. Click Save to update the pipe with the chosen fittings, and to close the 
Fittings screen. 

 
 

12.3  Adding a Fitting to the Database 

 
To add a fitting to the database: 
 

1. Click the Fittings  button on the calculation panel to open the Fittings 
screen. 
 

2. Click the Create Fitting button to open the Create New Fitting section of the 
Fittings screen. 

 
3. To change the symbol representing the fitting, click the Change button to 

open the Choose Symbol screen. 

 
4. Select the symbol you want to represent the fitting. 

 
5. Click OK to add the symbol to the Symbol field and close the Choose 

Symbol screen. 
 

6. Select the fitting’s metric size from the Metric list or select the fitting’s imperial 
size from the Imperial list. 
 

7. You only need to select the metric or imperial fitting size.  Pipe Flow Wizard 
automatically populates the other size for you.  For example, if you select 
32mm from the Metric list, the imperial equivalent, 1-1/4”, automatically 
appears in the Imperial field. 

Figure 50 Create New Fitting 

Figure 51 Choose Fitting Symbol 
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8. Enter a description of the fitting in the Description field. 

 
9. Enter the K value for the fitting in the K Value field. 

 
10. Click the Save Fitting to add the fitting to the Fitting Database list. 
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13 Flow Rate Calculator / Helper 

For Pressure Drop Calculation and Pipe Length Calculation, Pipe Flow Wizard 
incorporates a Flow Rate Calculator which uses the current internal diameter and a 
fluid velocity to calculate a flow rate. 

To open the Flow Rate Calculator: 

1. Click the Flow  expander button: 

 

 

 

 

 
 

 

 

 

2. Enter the required Velocity. 

 
3. As you enter the Velocity, Pipe Flow Wizard automatically calculates the 

Flow Rate and displays it beneath the velocity. 

 
4. Click OK to apply the calculated flow rate and close the Flow Rate 

Calculator. 

 
Whilst the Flow Rate Calculator is open, no other operations can 
be performed in the calculation panel. 

  

Figure 53 Flow Rate Calculator - Liquid Figure 52 Flow Rate Calculator - Gas 
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14 Calculations and Results 

Once you have entered the required input data to a Calculation Panel (e.g. Find 
Pressure), you can calculate the results for that data by clicking the Calculate 
button.  If the input data is valid, the Results Panel slides up and over the Calculation 
Panel to concisely display the calculated data. 

The values in the results panel can be scrolled up and down as needed, and where 
applicable, result value can be expanded to reveal additional information related to 
that attribute.  For more information about expanding attributes, see: Expandable 
Sections. 

 

 

14.1  Automatic Checks and Updates 

 
Before a calculation is solved, the software performs some automatic checking of the 
input data and allows users to accept various recommend updates to the make the 
calculation data consistent. 
 
 

14.1.1 Fitting Sizes 

Fitting sizes will be checked and matched to the nominal pipe size. 
 

 
If the nominal pipe size does not match some of the fitting sizes associated with the 
pipe, then the option to update the fittings sizes should normally be accepted.  This 
will update the fitting sizes and the fitting ‘K’ values so that the fittings pressure 
losses will be calculated correctly. 
 

Pipe Flow Wizard cannot automatically update fitting sizes for user 
defined fittings. 

 

 

 

 

Figure 54 Fitting Sizes 
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14.2 Configuring the System Results 

 
Once a calculation has been solved, the calculated results are displayed in the 
Results Panel.  The options selected in the Results Decimals and Units sections of 
Settings determine how the results values are displayed. 
 
 

14.3  Copying Calculation Results for use in another Calculation 

 
When a calculation has been solved and the results panel is on display, click the 

Copy  button to display the Copy Calculation pop-up menu. 

  

 

Click a menu item to copy the current calculation data to the input data of a different 
calculation, or copy it as the input data for all other calculations. 

 

The Copy Calculation action sheet is context sensitive and 
therefore will not include the active calculation in the menu. 

 

 

14.4  Creating a Report of the Results 

 
When a calculation has been solved and the Results Panel displayed, an Excel or 
PDF report can be created. 
 
To create an Excel Report, click the Excel button.  The report will be generated 
using the defined Reports settings and Pipe Flow Wizard will attempt to open it using 
Microsoft Excel (or compatible software) that is installed on your computer. 
 
To create a PDF Report, click the PDF button.  The report will be generated using 
the defined Reports settings and Pipe Flow Wizard will attempt to open it using 
Adobe Acrobat (or compatible software) that is installed on your computer. 
 

Figure 55 Copy Calculation Pop-up Menu 
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The options selected in the Results Decimals, Units and Reports sections of Settings 
determine how the results values are displayed. 
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14.5  PDF Report Example – Tabulated Units 

 

 
  

Figure 56 PDF Report - Tabulated - Liquid 

Figure 57 PDF Report - Tabulated - Gas 
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14.6  PDF Report Example – Non-Tabulated Units 

 

 
 
 
  

Figure 58 PDF Report - Non-Tabulated - Liquid 

Figure 59 PDF Report - Non-Tabulated - Gas 
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15 Working with Compressible Fluids 

The Pipe Flow Wizard software contains a Compressible Isothermal Flow 
Calculation Engine. 

In a gas system, as pressure loss occurs along a pipe, the gas density will decrease, 
and the volume of the gas will expand. As the volume of gas increases, the velocity 
of the gas in the pipe will increase. Although the volume of gas and velocity in the 
pipe changes, the mass flow (weight of flow) in the pipe will remain constant. 

Gas flow rates are therefore often referred to in terms of mass flow (weight of flow) 
or standard volume (which is the volume of gas at standard conditions, normally 
atmospheric pressure and some common temperature reference, since this standard 
volume also defines a constant mass flow). 

 

Pipe Flow Wizard provides a choice of standard volume units for gas flow rate which 
include: 

• SCCM (Standard Cubic Centimetres per Minute), 

• SLM (Standard Litres per Minute), 

• SCMH (Standard Cubic Meters per Hour) 

• MMSCMH (Million Standard Cubic Meters per Hour) 

• MMSCMD (Million Standard Cubic Meters per Day) 

• SCFM (Standard Cubic Feet per Minute) 

• SCFH (Standard Cubic Feet per Hour) 

• SCFD (Standard Cubic Feet per Day) 

• MMSCFH (Million Standard Cubic Feet per Hour) 

• MMSCFD (Million Standard Cubic Feet per Day) 
 

Each of the standard volume units for gas flow relate to the gas at a standard 
condition, however there are several slightly different standard reference conditions 
that are used worldwide depending on country and location. Pipe Flow Wizard 
provides a choice of standard reference conditions to be used when referring to the 
standard volume flow rate of gas and these include: 

 

• 0°C, 100.000 kPa.a 

• 0°C, 101.325 kPa.a 

• 15°C, 101.325 kPa.a 

• 20°C, 101.325 kPa.a 

• 25°C, 101.225 kPa.a 

• 60°F, 14.696 psi.a 

• 68°F, 14.696 psi.a 
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Mass flow can also be used to refer to an amount of gas flow and the units for mass 
flow include: 

 

• kg/sec 

• kg/min 

• kg/hour 

• lb/sec 

• lb/min 

• lb/hour 

 

15.1 Defining Gas Data 

 
The calculations incorporate use of the Ideal Gas Law and if required a custom 
Compressibility Factor or use of the CNGA Compressibility Factor (that is calculated 
based on the pressures at the start and end of the pipe). 
 

The Compressible Flow Calculation Engine will automatically take account of 
pressure changes within the pipe and will automatically adjust the density properties 
of the gas as appropriate when performing the gas flow rate, pressure loss, diameter 
size, and pipe length calculations. The equations used in the calculations currently 
assume isothermal flow where there is no change in temperature.  
 

The Pipe Flow Wizard software will automatically account for changes in pressure 
and gas density within the pipe, however the original fluid properties must be defined 
for the operating temperature within the pipe (although the density may have been 
specified for a different pressure condition). 
 

Normally the gas properties should be defined for the atmospheric pressure 
condition (0 bar.g or 0 psi.g) and the software will then automatically calculate the 
gas density at the start pressure condition prior to performing the appropriate 
calculation.  
 

If the start pressure is a high pressure, and the real gas density at this condition 
varies from the ideal gas law prediction, then a compressibility factor other than 1.0 
can be specified. This will be applied when calculating the gas density at the start 
pressure condition prior to performing the appropriate calculation.  
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15.1.1 Gas Calculator Data  

 

The gas calculator helper within the Fluid Database can calculate and display the 
compressibility factor of certain gases at different temperature and pressure 
conditions, and it will show the real density of the gas at the specified condition. 

 

The user should choose to either: 
 

1. Define the gas properties at a condition on the ideal gas law line (normally say 
0 bar.g) and then specify on the Options screen an appropriate 
compressibility factor for the pressure condition at the start of pipe. 
 
OR 
 

2. Define the gas properties at the start pressure condition using the real gas 
density at this pressure (if it differs from the predicted ideal gas law density at 
this condition) and then specify the compressibility ‘Z=1.0’. 

 
This ensures that the calculation proceeds to use the correct real gas density at 
the start pressure condition. 
 
i.e.  
 
a) If the gas properties are specified on the ideal gas law line then the predicted 

gas density at the start pressure condition will then be adjusted according to 
the compressibility factor that has been specified, in order to end up with the 
real gas density at the start condition.  
 

OR 
 
b) If the gas properties are defined at a high-pressure condition, specifying the 

real gas density, then a compressibility factor of ‘Z=1.0’ should be used. The 
calculated density at the start pressure condition will then be derived from the 
real gas density (at the high-pressure condition) by applying the ideal gas law 
equation. This will normally give a good result in terms of predicting the real 
gas density at the start of the pipe, provided that the defined high-pressure 
condition and the start pressure are not too different. 

 
This means that the gas properties should generally be specified on the ideal gas 
law line and a compressibility factor can be specified as appropriate, or if the real 
gas density is specified for the gas at a high-pressure condition at the start of the 
pipe then the compressibility factor should be set to 1.0. 
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15.2 Using Compressible Flow Equations 

 

 

There are a number of different equations that can be used to calculate flow rate and 
pressure loss in a compressible gas system and the type of design and user 
preference often determines which equation is chosen to calculate the results. 

The Pipe Flow Wizard software allows for the selection of a specific compressible 
isothermal flow equation from a list that includes: 

• General Fundamental Isothermal Flow Equation 

• Complete Isothermal Flow Equation 

• AGA Isothermal Flow Equation 

• Weymouth Isothermal Flow Equation 

• Panhandle A Isothermal Flow Equation 

• Panhandle B Isothermal Flow Equation 

• IGT Isothermal Flow Equation 

 

The General Fundamental Isothermal Flow Equation (sometimes known as just 
the General Flow equation or the Fundamental Flow equation) provides perhaps the 
most universal method for calculating isothermal flow rates, however it relies on the 
inclusion of an accurate friction factor. The Pipe Flow Wizard software provides such 
a friction factor by calculating this using the Colebrook-White equation. 

The preferred equation and method of calculation can be selected by clicking the 

Options  button on the calculation panel. 

Figure 60 Compressible Flow Equations 
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16 Calculation Theory and Method of Solution 

The Pipe Flow Wizard software allows you to calculate the pressure loss, or the flow 
rate, or the required pipe diameter size, or the applicable pipe length, depending on 
what other information is known. The reported results include flow rates, fluid 
velocities, Reynolds numbers, friction factors, friction pressure loss, fittings, pressure 
losses and more.  

 

16.1  Fluid Flow States 

 
Fluids in motion are subjected to various resistance forces, which are due to friction.  
Friction may occur between the fluid and the pipe work, but friction also occurs within 
the fluid as sliding between adjacent layers of the fluid takes place. 
 
The friction within the fluid is due to the fluid’s viscosity.  When fluids have a high 
viscosity, the speed of the flow tends to be low, and resistance to flow becomes 
almost totally dependent on the viscosity of the fluid. The condition is known as 
‘Laminar flow’. 
 
Fluids which have a low viscosity are usually moving at higher velocities.  The flow 
characteristics change, small eddy currents occur within the flow stream, and the 
friction between the pipe work and the fluid becomes a factor to be considered. This 
type of flow is known as ‘Turbulent flow’. 
 
 

16.2  Fluid Viscosity 

 
A fluid viscosity can be described by its Dynamic viscosity (sometimes called 
Absolute viscosity), or it’s Kinematic viscosity.  These two expressions of viscosity 
are not the same, but are linked via the fluid density. 
 
Kinematic viscosity = Dynamic viscosity / fluid density 

 

Dynamic Viscosity 

Water @ 20°C has a viscosity of 1.00 x 10 -3 Pa • s or 1.00 Centipoise 
Water @ 70°F has a viscosity of 2.04 x 10 -5 lbf •s/ft² 

 
Kinematic Viscosity 

Water @ 20°C has a viscosity of 1.004 x 10 -6 m² /s or 1.004000 Centistokes 
Water @ 70°F has a viscosity of 10.5900 x 10 -6 ft² /s 
 
 
Pipe Flow Wizard has a database of viscosities and densities for common fluids. 
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16.3  Reynolds Numbers 

 
Reynolds numbers (Re) describe the relationship between a fluid’s velocity, the 
internal pipe diameter and the fluid’s Kinematic viscosity. 
 
Reynolds number = Fluid velocity x Internal pipe diameter / Kinematic viscosity 
 
Note: Kinematic viscosity (not Dynamic viscosity) must be used to calculate 
Reynolds numbers.  It is generally accepted that the ‘changeover’ point between 
laminar flow and turbulent flow, in a circular pipe, occurs when the Reynolds number 
(Re) is approximately 2100. 
 
i.e. Laminar flow occurs when the Re is less than 2100.  Turbulent flow occurs when 
the Re is greater than 4000.  Between the Laminar and Turbulent flow conditions the 
flow may be neither wholly laminar nor wholly turbulent.  In this transition region 
there is no exact equation to calculate the friction factor and therefore only an 
approximate friction factor can be used by way of appropriate interpolation. 
 
 

16.4  Friction Factors 

 
Many formulas have been developed to model the flow of fluids.  The Hazen-
Williams formula has been a popular method of estimating the head loss in piping 
systems for many years (particularly prior to the availability of today’s modern 
computers).  However, this empirical formula will only give reasonable accuracy if 
the fluid is water at 60oF or similar. 
 
The Colebrook-White formula may be used with confidence to calculate an accurate 
friction factor applicable to the turbulent flow of fluids. The Colebrook-White formula 
is applicable over a whole range of fluid densities and viscosities, provided that the 
fluid flow is turbulent. 
 
The Pipe Flow Wizard software uses the Colebrook-White friction factor with the 
Darcy-Weisbach equation when calculating friction loss for non-compressible flow 
(liquids). The Colebrook-White friction factor is also used with some compressible 
gas flow equations such as the General Fundamental Flow equation. 
 
 

16.5 Colebrook-White Formula 

 
The Colebrook-White formula: 

 

1/sqrt(f) = 1.14 – 2 log10 [e/D + 9.35/(Re x sqrt(f))] 

 

f = friction factor 
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e = internal roughness of pipe 

D = internal diameter of pipe 

Re = Reynolds number 

 
Friction factors for turbulent flow calculated by Pipe Flow Wizard are based on the 
Colebrook-White formula. 
 
The friction factor for Laminar flow is calculated from f = 64/Re 
 

16.6 Friction Losses (Resistance to Flow) 

 
For liquids, the resistance to fluid flow is usually expressed in fluid head.  This is the 
height of a column of fluid which would exert enough pressure on the fluid at the 
bottom of the column to make the fluid flow. 
 
If the level of the fluid (fluid head) is increased in a supply container, the volume of 
fluid entering the system from the supply container will increase due to the increase 
in pressure (force). 
 
 

16.7 Darcy-Weisbach Formula 

 
For non-compressible fluids (liquids), fluid head resistance can be calculated by 
using the Darcy-Weisbach formula. 

 

h fluid = f (L/D) x (v ²/2g) 

 
f = friction factor 
L = length of pipe work 
D = inner diameter of pipe work 
v = velocity of fluid 
g = acceleration due to gravity 

 

Fluid head loss calculated by the Pipe Flow Wizard software when using the non-
compressible (liquid) calculation engine is based on the Darcy-Weisbach formula.  
 
This formula can be used for compressible (gas) calculations provided that the gas 
density at the start of the pipe is used to determine the fluid velocity, and provided 
that the pressure drop in the pipe is less than ten percent of the absolute pressure at 
the start condition.  
 
For compressible (gas) calculations where the pressure drop is more than ten 
percent, but less than forty percent of the absolute pressure at the start of the pipe, 
the equation gives reasonable results provided that the gas density at the average 
pressure condition in the pipe is used to calculate the average velocity of the gas. 
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The Pipe Flow Wizard software however, does not allow use of the Darcy-Weisbach 
equation for compressible gas calculations since it uses the more accurate specialist 
compressible gas flow equations, which provide more accurate results, and which 
are not limited to working with pressure drops of up to a certain percentage of the 
initial start pressure. 

 

16.8 Fitting Losses 

 
The fluid head resistance through various pipe work fittings can be calculated if the 
'K' factor of the fitting is known. Many manufacturers of pipe work fittings and valves 
publish 'K' factors for their products. 

 

16.8.1 ‘K’ Factor Fitting Head Loss Calculation for Liquids 

 

For non-compressible (liquid) systems, fluid head loss through fittings and valves 
can be calculated from the following equation: 

 

h fluid = 'K' x v ² / 2g 
 

'K' = manufacturer’s published 'K' factor for the fitting 
v = velocity of fluid 
g = acceleration due to gravity 

 

16.8.2 Equivalent Length Head Loss Calculation for Gases 

 
For compressible gas flow calculations, the Pipe Flow Wizard software converts the 
‘K’ factor of the fitting to an equivalent length of pipe, which will result in the same 
friction loss. This is done automatically during the calculation. 
 
A ‘K’ factor can be converted to an equivalent length of pipe when the diameter of 
the pipe is known. 
 
Equivalent length = (K factor * Diameter) / Friction factor 
 
The Pipe Flow Wizard software allows fittings to be placed at both the start and the 
end of the pipe, and with compressible flow, when pressure loss occurs along the 
pipe, the gas will ‘expand’ (become less dense), hence it’s velocity will increase, to 
maintain the same mass flow rate. 
 
The ‘K’ factor method for calculating head loss across a fitting requires that the 
density of the fluid entering the fitting is known, since the result is a head loss that is 
relative to this density, and with a compressible gas flow calculation, where there are 
fittings at the start and end of the pipe, the density of the gas is different at these 
points. In addition, the starting pressure of a gas flow calculation affects the overall 
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friction loss results (for the same flow rate) and therefore technically if there are 
fittings at the start of the pipe then the loss through these must be accounted for and 
the pressure immediately after the fittings would then need to be used as the start 
pressure for the friction loss calculation. 
 
Using the equivalent length method for compressible gas flow calculations simplifies 
the problem. Once the overall loss through the pipe has been calculated (including 
the additional equivalent length for the fittings) then the amount of loss through the 
fittings at the start and the end of the pipe can be apportioned appropriately to break 
out the results in to the fittings losses and the pipe friction loss. 
 

16.8.3 Fittings Database 

 
Pipe Flow Wizard has a database of valve and fittings ‘K’ factors and calculation 
helpers for: 
 

• gradual enlargements 

• gradual contractions 

• sudden enlargements 

• sudden contractions 

• rounded entrances 

• long pipe bends 
 
 
In systems where pipe lengths are relatively long, the effect of the fitting losses for 
bends may be minor (in comparison to the long pipe friction losses) and in these 
cases, fitting losses are sometimes ignored during initial assessment of the system. 
 
If a partially open valve is part of the design, the effect of the valve should always be 
considered as the valve loss may be large. 
 
 

16.9 Compressible Gas Flow Equations 

 
Friction loss for a compressible fluid, such as a gas, needs to account for the change 
in density, as the gas moves along the pipe and loss of pressure occurs. When using 
the compressible flow calculation engine Pipe Flow Wizard can be set to use one of 
the following compressible flow equations:  

 

• General Fundamental Isothermal Flow Equation 

• Complete Isothermal Flow Equation 

• AGA Isothermal Flow Equation 

• Weymouth Isothermal Flow Equation 

• Panhandle A Isothermal Flow Equation 
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• Panhandle B Isothermal Flow Equation 

• IGT Isothermal Flow Equation 

 

The formula for each of the above equations is detailed in a separate PDF document 
named ‘Compressible Flow Equations’. This PDF is available from the ‘Verification’ 
menu inside the Pipe Flow Wizard software.  

  



Pipe Flow Wizard for Windows  User Guide 
 

 88 

17 Glossary 

Term Description 

Absolute Pressure 
 

Pressure measured with respect to zero pressure. 

Atmosphere 
A standard atmospheric pressure of 1.01325 bar a or 
14.696 psi a. 

Centipoise 
Absolute viscosity of a fluid expressed in Pa • s x 10-3 

 

Centistokes Kinematic viscosity of a fluid expressed in m2/s x 10-6 

Colebrook-White 
equation 

An equation used to calculate accurate friction factors 
from the internal diameter and internal roughness of a 
pipe and the Reynolds number for the flow conditions. 

Darcy-Weisbach 
equation 

An equation used to calculate the frictional head loss 
due to fluid flow from the friction factor, the length and 
diameter of the pipe, the velocity of the fluid and the 
gravitational constant. 

Friction Factor 
A factor to be used in the Darcy-Weisbach equation.  
Either calculated from the Colebrook-White equation 
or ready from the Moody diagram. 

Entry Pressure The pressure at the start of the pipe. 

Exit Pressure The pressure at the end of the pipe. 

Fixed Pressure Loss 
A static pressure loss which is independent of the 
flow rate. 

K Value 
Coefficient of frictional loss through a valve or pipe 
fitting. 

Moody Diagram 
A graphical representation of the relationship 
between Reynolds number, relative roughness and 
Friction factor. 

Pressure Loss 
The friction loss due to fluid flow expressed in a 
relative fluid head or a non-relative unit of pressure. 

Reynolds Number 
A dimensionless number derived from the fluid 
velocity, the internal diameter of the pipe and the 
Kinematic viscosity of the fluid. 
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Vapor Pressure 
The absolute pressure at which a liquid will start to 
evaporate. 

Viscosity A measure of a fluid’s resistance to flow. 

 


